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INTRODUCTION 

Windchill PDMLink Pro/ENGINEER (Pro/E) Wildfire Extension is the ability to manage and control your data. 
PDMLink Pro/E Wildfire Extension delivers data management capabilities within the PDMLink environment. It 
understands Pro/E files and all their detailed inter-relationships. 

Product Capabilities:  

• Maintain and organize secure data through the use of ORACLE technology  

• Access database tools for easily finding and re-using data, attributes, system-wide renames, lifecycle 
tracking and release controls  

• Integrate Pro/E designs, relationships and functionality with Windchill PDMLink Product Structure  

• Work with specific product configurations and incorporate design changes and conflicts from many 
sources  

• Communicate design status, release procedure status, activity and intent of other users to entire design 
team, enabling rapid local changes  

Customer Benefits:  

• Increased efficiency through a common working environment for Pro/ENGINEER users 

• Ensured data integrity through secure access to data and design history 

• Quicker time to market through effectively managed design changes and avoidance of design conflicts 

• Increased productivity of engineers through simplified information management 

• Shared engineering data with enterprise systems through Web-based environment 
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1 Software Configuration 

The base PTC components of this entire configuration is: 
 

PDMLink Server Products Release 6.2.6.06 
 Oracle 10G 
 Apache 
 Tomcat 
 Aphelion  

Java(TM) 2 SDK, Enterprise Edition 1.4.2_10international version 
Java 3D for 1.3.1 
PDMLink Foundation 8.0 

 Windchill Visualization Service 
 Both Language Pack CDs 
 Service Pack M020 
 RetrievalWare 
  

CAD Worker 
 Pro/E Wildfire 2 
 ProductView CAD Adapters M020 for Pro/E Wildfire 
 Windows File Transfer Protocol in Internet Information Services only 
 
Pro/ENGINEER Wildfire Clients 
 Internet Explorer with all active X enabled in internet security options 
 ProductView Standard Edition M020 for Windchill PDMLink 
 Java(TM) 2, Runtime Environment 1.4.2 
 Pro/ENGINEER Wildfire 2 M200 

 
NOTE:  You will need at least one licenses of Pro/ENGINEER, for the CAD Worker 

Since Apache Web Server, Tomcat Servlet Engine, Info*Engine, Excalibur RetrievalWare and PDMLink, are placed on 
the same server, the recommended minimum amount of RAM is 2 GIGs for production. 

1.1 Recommendations 

It is best to have the CAD Worker on a separate machine because it requires a considerable amount of resources to 
create the ProductView viewables from Pro/E. 
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2 Client Workstation Configuration 

To perform administrative configuration on the PDMLink server and properly use the ProductView Express, Standard 
Edition and Lite versions via the web browser, ActiveX security controls must be configured on the clients Internet 
Explorer.  To properly display PDMLink applets, a Java(TM) 2, Runtime Environment 1.4.2_10 software is be installed 
on each clients machine.  
 

2.1 Active X Security Options Enabled on a Windows Internet Browser 

To view thumbnails and ProductView viewables and thumbnails in various ProductView applications, the Windows 
Explorer security options must be configured for ActiveX controls.  The configurations are as follows: 

1. In the Menu Bar of the Windows Internet Explorer, select the Tools drop down list and select the Internet Options.  

 
 

2. In ther General Tab, delete all Temporary 
Internet files and reset the settings. 
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3. In the Internet Options, select on Custom 
Level button for the setting of Trusted Sites 
and Local intranet. 

 

4. Enable the ActiveX controls according to 
below and select OK button: 
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4. Disable Pop-up Blocker 

 
 

2.2 Clearing Pro/ENGINEER Workspace Cache (workstation and client login dependent) 

In your respective Application Data folder, delete the “.wf” directory: 

C:\Documents and Settings\<your user name>\Application Data\PTC\ProENGINEER\Wildfire\.wf 

 

2.3 Clearing JRE Cache (workstation and client login dependent) 
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2.4 Product View Standalone Client 
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3 Pro/E Wildfire Integrated With PDMLink 

Pro/E Wildfire has an embedded web browser.  Pro/E Wildfire’s embedded web browser allows the Pro/E user to use one 
interface to perform most of engineering functions.  In order to have Pro/E drawings, assemblies and parts to be managed 
by PDMLink, each client of Pro/E must communicate to PDMLink via a registry server service in PDMLink.  Currently, 
there is no functionality of renumbering.  It is best practice to ensure that the Pro/E file has a correct part, assembly or 
drawing number prior to uploading.  It is best to work on the files locally.  All required start files are managed in the 
PDMLink database. 

3.1 Server Registry Configuration 

Pro/E Wildfire can connect to multiple PDMLink/Windchill servers.  The Pro/E clients at Asahi Matsushita are only 
required to connect to one PDMLink server called plm.ad.psion.com.  The next steps will properly show how to connect 
to plm.ad.psion.com. 

1. In the menu bar, select Tools then Server Registry. 
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2. A Server Registry applet will appear to connect to the PDMLink server.  Select the Add button. 

 

3. In the Register new server applet, enter plm and plm/Windchill for values of Name and location respectively.  
Select the Check… button and log in applet prompt an authentication. 
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4. If there are no workspaces in the user’s personal cabinet, the only selection is the default workspace.  Select the 

OK button.  To integrate the Pro/E client with the PDMLink server, select the →Set… button with the 
plm.ad.psion.com alias highlighted. 

 

 

3.2 Create Workspace for Pro/E Wildfire Clients 

For every PDMLink user, there exist a hidden personal cabinet in the database.  A workspace is a directory or folder 
within that user’s personal cabinet.  There are many default functionality of Pro/E Wildfire integrated PDMLink.  They 
are: 

a) Files can be uploaded into the workspace and the PDMLink number and name will be assigned the complete file 
name with the extension.  In section 7, customizations are discussed to remove the extensions from the 
PDMLink number and name for WTParts. 

b) Cannot browse to CAD document templates via Pro/E Wildfire configuration tool. 

c) Cannot delete WTParts and CAD documents. 

d) Cannot renumber or rename parts. 

e) The name and description PDMLink system attribute is a non-versioned or iterative attribute. 

f) Because the workspaces are in the database, every object regardless of location has to be unique; therefore, 
objects can’t be located in multiple locations or workspaces.  The methodology is to download. 

g) No Uploading in Default_WS 

h) Cannot delete workspace if the workspace is still set or the PDMLink server is set on server registry.  

Because of default functionality, it is best to keep the workspaces of each user to a minimum. 

1. To create a workspace, select the 
Workspace tab in the Server Registry 
applet.  Then select the New button. 

2. Enter Std_Library for name of the 
workspace and then select the OK 
button. 
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3. Finally, highlight the Std_Library workspace and select the →Set… button and then Close to 
complete the integration. 

 

3.3 Uploading and Checking In Pro/E Wildfire Standard Library Model Files 

When implementing Pro/E with a PDM system, it is best practice to manage Pro/E model files in the PDM database.  As 
a result, history and control of all Pro/E model based files in a database would be part of the methodology.  It is best 
practice to store the Pro/E modeled standard library files in a library container that will be shared by all end users.  Also, 
all the configurations are stored Pro/E standard library model files in CAD documents objects in PDMLink.  These files 
must be uploaded and checked into the ProE_Std_Library library container.  The following steps will describe how to 
complete this task with the template solid model startwildfire.prt. 

1. Open the startwildfire.prt where it resides on the Std_Library server in the directory and select the save option.  
Delete any Pro/E user defined parameters that are redundant to the PDMLink’s Pro/E controlled parameters.  
Also, it is best practice to rename any parameters that are spelled the same as the PDMLink system attributes. 



 

PAGE:  15 OF 33 

 

 

2. In the menu bar under File, select the Save and Upload.  The upload function will save the file into a CAD 
document with the PDMLink number and name with the file name startpartwildfire.prt.  Uploading it to the 
database will also assign a PDMLink revision/version and iteration value. 

 

 



 

PAGE:  16 OF 33 

3. A new CAD Document startpartwildfire.prt is now present in the Std_Library workspace.  This CAD document 
object will be checked into the library container called ProE_Std_Library.  Select the startpartwildfire.prt by 

checking the check box then select the check in icon  in either the workspace menu or in the Actions 
options. 

 

4. A check in window will appear in the embedded browser.  Update the location for object to check. 
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5. Browse to the through the PDMLink repositories and select the ProE_Std_Library library container. 

  



 

PAGE:  18 OF 33 

6. Finally select OK after highlighting the ProE_Std_Library. 

 

The check in page will refresh with the new location and then select OK. 

It is best practice to check in all Pro/E model files in the ProE_Std_Library in the PDMLink database that are located 
in the following local directories: 

<ProE_Std_Wildfire>\formats 

<ProE_Std_Wildfire>\library 

<ProE_Std_Wildfire>\start_files 

 

The remaining files are only for the Pro/E software application.  These files are to be stored in the shared local hard 
drive H:\. 

3.4 Deletion of Workspace 

To keep Workspaces to a minimum, it is advisable to delete workspaces.  To properly delete workspaces, there are 2 
prerequisites: 

a) The workspace to be deleted is not set. 

b) If it is the only workspace, the PDMLink registry server alias is not set. 

c) The workspace has to be empty of objects. 

In the Home tab of the Windchill-PDMLink page and check the workspace to be deleted then select the Delete 

Workspace icon . 
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4 Pro/E Wildfire Configuration 

The standard Pro/E Wildfire configuration file, configwildfire.pro, which is located in 

<ProE_Std_Wildfire>\configs 

is copied to all local clients installations of Pro/E.  This must be modified to incorporate a PDMLink database 
management methodology.  All configurations will be performed through the Pro/E interface. 
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4.1 Cache 

Cache is used for temporary storage for the Pro/E Workspaces.  This increases the performance of retrieving data in you 
Pro/E session rather than searching it elsewhere. 

4.1.1 Cache Location  

Cache directory is a fixed directory where there is large local shared space for all users.  All users will require full 
access to this directory. It is recommended place cache on local disk where there are no OS and other applications 
installed.  This will avoid OS or application failure.  It is recommended to create a system environment variable called: 

TMP   <directory location> (not a network directory for better performance) 

PROE_CACHE  <directory location> (if possible another local drive) 

 

The following lines must be added to the config.pro to enable the cache locations. 

PTC_WF_ROOT $TMP 

PTC_WF_CACHE $PROE_CACHE 
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4.1.2 Cache Size 

The default cache size is 400 MEG per workspace.   If you would like to state another value to be tailored to the limits 
of you machine and the number of workspaces created by all users.  Administrators should allocate disk space by this 
formula 

# of Pro/E users per workstation X average number of workspaces X cache size X 2 = total cache space  

dm_cache_size 400 (set at 400 MEG for each workspace) 

4.2 Reset to Last Workspace 

When exiting and opening Pro/E, a configuration option can be set to his last accessed workspace.  The default is set to 
true (YES).  The other option is NO.  The configuration property is: 

dm_remember_server YES 

4.3 Model Display in Pro/E Client 

Set the following for the thumbnail view for the ProductView Express functionality in the embedded browser. 

save_model_display shading_lod both 

4.4 File Compression for Upload and Download 

Integer, from 0 (no compression) to 9 (maximum compression)  [default = 0] Sets the level of compression for data 
upload and download.  Although compression speeds up transfer over the network, it uses server CPU and client CPU to 
perform the compress and decompress operations. In a local area network, where network transfers are rapid, 
compressing and decompressing data can result in lesser throughput. On wide area network with lower bandwidth 
compression can lead to higher throughput. Since this is set per client, PTC recommends that clients in a LAN use a 
value of 0 (the default) and clients in a WAN use a value of 2 or 3. 

There is a balance between Pro/E Client performance and network throughput and data storage.  Pro/E Client best 
performance is at no compression while the best performance in a network and database file throughput and retrieval 
respectively is at maximum compression.  At , the configuration option was set to 5. 

dm_http_compression_level 5 

 

4.5 Default Web Page 

The default web page can be set by this property: 

web_browser_homepage http:// http://www.ptc.com/support/support.htm 

 

4.6 PDMLink Registry Server Connection Retries 

The default number of attempts to connect to the PDMLink Registry connections after a failure is 10 times.  This 
configuration sets the number of attempts to connect to a PDMLink server before the connection is considered broken.  
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(This is a hidden config option that was introduced in Pro/ENGINEER Wildfire date code 2003210.)  The recommended 
setting is the default.  If the http connection is unstable, a setting less than the default could increase failures, while a 
setting greater than the default causes delays if a failure occurs.  In , the configuration value was set to 5. 

dm_network_retries 5 

4.7 Concurrent Download Threads 

The default value for this configuration option is 3.  This option sets the number of concurrent threads Pro/ENGINEER 
uses for downloading data from a PDMLink server.  In most cases, increasing the number of threads in a LAN 
environment will not improve performance, as the disk will then become the bottleneck. Even in a WAN environment, 
settings greater than the default are unlikely to improve throughput significantly. (This is a hidden config option that was 
introduced in Pro/ENGINEER Wildfire date code 2003210.)  PTC recommends this option to be default. 

dm_network_threads 3 

4.8 Automatic Upload to the Primary PDMLink server User’s Personal Cabinet Workspace folder in the  

Database  

This configuration option defines the behavior of the Save command in Pro/ENGINEER.  If this option is set to explicit, 
the Pro/ENGINEER File > Save command will write data to the local disk space and cache. The user must then 
explicitly upload/send that data to the PDMLink server (using either File > Save and Upload, File  > Upload, or File > 

Checkin).  If this option is set to automatic, File > Save in Pro/ENGINEER will also upload the Pro/ENGINEER files 
to the PDMLink User’s Personal Cabinet Workspace folder.  For best practices, PTC recommends that this value is set 
to automatic when connected to a PDMLink server.  Files will be both saved on the database and locally on disk. 

dm_upload_objects automatic 

4.9 Automatic Upload to the other Secondary PDMLink servers User’s Personal Cabinet Workspace folder in 

the  Database 

Pro/E Wildfire can connect to multiple PDMLink servers, this option defines the behavior of saving to a secondary 
server (See also dm_upload_objects). 

dm_secondary_upload automatic 

4.10 File Retrieval Options 

To ensure that the setting files are securely located and readily available, it is recommended to store setting files in the 
PDMLink Oracle database.  Thus, history in changes will be maintained and proper security controls are placed for CAD 
administration methodology.  The setting files are checkin to a read accessible Pro/E standards Library container in 
PDMLink.  The config.pro options that specify storage and retrieval directories, including such options as the following: 

• start_model_dir 

• pro_library_dir 

• pro_format_dir 

can be set to point to Windchill cabinets. For example, the value of start_model_dir is set to point to a Windchill 
PDMLink library container cabinet using the following syntax: 

start_model_dir wtpub://<server_alias>/Library/<library container_name> 
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Since all the files were stored in a single library container, the configuration is as follows: 

start_model_dir wtpub://plm.ad.psion.com/Library/ProE_Stds_Library 

for all the directories as stated above. 

Note: If you retrieve an object from any location other than the primary server, it will be treated as if it were newly 
created in the Pro/ENGINEER session. This means that actions on the object (for example, save or requesting checkout) 
are done in the context of the primary server, not the location from which the object was retrieved. 

Config.pro options that point to a specific file, including such options as the following: 

• intf_in_use_template_models 

• template_designasm 

• template_mold_layout 

• template_ecadprt 

• template_solidpart 

can be set to point to Windchill file locations using a string of the proper syntax and the name of the CAD document that 
manages the file, as in the following example: 

template_solidpart wtpub://<server_alias>/Repositories/Templates/template_solid_inlbs.prt 

In , the configuration is as follows for the template_solidpart: 

template_solidpart wtpub://plm.ad.psion.com/Repositories/ProE_Stds_Library/startpartwildfire.prt 

The other templates configurations have been modified to their respective CAD documents: 

template_sheetmetalpart wtpub://plm.ad.psion.com/Library/ProE_Stds_Library/ startpartsheet_wildfire.prt 

template_designasm wtpub://plm.ad.psion.com/Library/ProE_Stds_Library/ startasmwildfire.asm 



 

PAGE:  25 OF 33 

5 Customizations to PDMLink Server 

Currently by default, PDMLink assigns the PDMLink number and name system attributes of the WTPart and CAD 
document to the Pro/E file name with the extension. 

 

 

As a result, the product structure or bill of material will be displayed in the WTPart assembly as shown below: 
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To avoid this default behaviour, small customizations are added to the PDMLink codebase.  To ensure Pro/E standard 
library repositories, products and templates have to be created in PDMLink.  Some ‘ini’ files are modified to ensure that 
the Pro/E clients can create parts and drawings from these files.  These repositories and products are required to store 
Pro/E start part/assembly and drawing format templates.  Pro/E symbols. 

All of the customizations are taken from the Windchill® Customizer’s and Administrator’s Guide for Pro/ENGINEER® 
Wildfire™ for Release 6.2.6.  Before any customizations take place, a backup of the entire PDMLink installation 
directory must occur.  Also, an export of the PDMLink Oracle user schema is required for backup purposes.  PDMLink 
MethodServer, ServerManager and Tomcat must be shutdown prior to performing the customizations.  It is best practice 
to delete the Tomcat default cache directory which is located in %TOMCAT_HOME%\work\ directory. 

5.1 Automated Part Creation 

Automated WTPart creation (or Autopart) is a mechanism for automatically creating WTParts, and links to them, for 
one or more selected CAD documents.  Automatic WTPart creation can be invoked either by clicking the workspace 
Auto Create Part icon, or by checking the Create or Associate Docs to Parts box on the Options page during 
checkin.  The Autopart feature in Windchill Release 6.2.6 supports the delegate class mechanism. The customizers are 
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given full control over the naming and numbering of the WTPart being created. The same applies to direct check in 
(provided the option to create and associate WTParts to documents is selected), which invokes the same method to auto-
create the part.  To customize the Autopart feature perform the following steps: 

1. Create a class that implements the com.ptc.windchill.cadx.autopart.AutoPartCreator interface. 

Note: The only method the AutoPartCreator interface has is: 

public WTPart createAutoPart( EPMWorkspace wsp, EPMDocument doc ) -- 

throws WTException, WTPropertyVetoException; 

2. Implement this method in the customized class. 

3. Modify the autopart.ini preference file located at WT_HOME\codebase\com\ptc\windchill\cadx\cfg\site 
accordingly. 

For example, the default entry in the file is as follows: 

[general] 

autoPartCreator=com.ptc.windchill.cadx.autopart.DefaultAutoPart 

Creator 

You can specify the custom class name as the value of key autoPartCreator here: 

[general] 

autoPartCreator=ext.wildfire.autopart.NoExtensionAutoPartGenerator 

The autoPartCreator preference is applicable to the entire site.  Example: 

Note: The following example creates WTParts that have the same name as the source CAD Document, but without the 
file extension (for example, A Pro/ENGINEER model called 12345.prt would yield a WTPart called 12345) 

// AutoPartGenerator for Wildfire 

// Part Number = associated EPMDoc number /wo Pro/E extension 

package ext.wildfire.autopart; 

import com.ptc.windchill.cadx.common.WTPartUtilities; 

import wt.epm.EPMDocument; 

import wt.epm.EPMDocumentType; 

import wt.epm.workspaces.EPMWorkspace; 

import wt.fc.EnumeratedType; 

import wt.part.PartType; 

import wt.part.WTPart; 

import wt.util.WTException; 

import wt.util.WTPropertyVetoException; 
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public class NoExtensionAutoPartGenerator implements 

com.ptc.windchill.cadx.autopart.AutoPartCreator 

{ 

private final int VERBOSE_LEVEL=9; 

public NoExtensionAutoPartGenerator() 

{ 

} 

public WTPart createAutoPart(EPMWorkspace epmworkspace, 

EPMDocument epmdocument) 

throws WTException, WTPropertyVetoException { 

String epmNumber = epmdocument.getNumber(); 

String epmName = epmdocument.getName(); 

printMsg(1,"NoExtensionAutoPartGenerator.createAutoPart: 

EPMname="+epmName+" EPMnumber="+epmNumber); 

EPMDocumentType epmdocumenttype = 

EPMDocumentType.toEPMDocumentType("CADASSEMBLY"); 

PartType parttype; 

if(epmdocument.getDocType().equals(epmdocumenttype)) 

parttype = PartType.SEPARABLE; 

else 

parttype = PartType.COMPONENT; 

String epmNumberNoExt = stripExtension(epmNumber); 

String epmNameNoExt = stripExtension(epmName); 

printMsg(1," --> Creating new part: 

Name="+epmNameNoExt+" Number="+epmNumberNoExt); 

return WTPartUtilities.createNewPart(epmNumberNoExt, 

epmNameNoExt, parttype, null, 

epmworkspace); 

} 

private String stripExtension(String name) { 

int k = name.indexOf("."); 

String nameWoExt; 
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if (k > 0) 

return name.substring(0, k); 

else { 

printMsg(0,"*** EPMDoc without extension...."); 

return name; // well, just return name 

} 

} 

private void printMsg(int level, String s) { 

if (level<=VERBOSE_LEVEL) 

System.out.println(s); 

} 

} 
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6 Access Controls on Library Domains in PDMLink 

An administrator will be only managed this library container with access controls.  In the Administration page under the 
Administration tab.  Select the Policies hyperlink. 

 

1. A login applet and a Policy Administrator applet imbedded in web page will appear on the desktop window.  (allow 
the downloading of the client jar files for better performance and synchronizing with PDMLink classes on the 
server)  Log on as the PDMLink administrator. 
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2. In the Policy Administration web page, expand the PDMLink Domain to display the sub-domains.  Select the 
ProE_Std_Library that you just created, then select the Update button. 

 

3. An Administrative Domain applet will appear and select on the Access Control Tab.  To ensure that all access 
controls are displayed, select the Retrieve button.  To allow only administrative rights for modifications to 
PDMLink objects stored in this domain, create a new Read access for all Pro/E end users.  Select Create button. 

 

4. An Access Control Rule Window will appear.  Create a read Access Control Rule for all non administrators with the 
following settings: 

a. Object Type: WTObject 

b. Lifecycle State:  Released 

c. Access Permission:   Grant column – Read selected 
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d. User Groups: Non Administrators. 

Note: A separate access control rule must be created for each group, user (if necessary) and role (if necessary).  
Select Apply button for each new rule except for the last.  For the last access control rule, select OK button and 
the applet will save and close.  When Apply button is selected, the applet will remain open.  Thus, to close the 
applet, the Cancel button must be selected. 
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7 Best Practices with the Current PDMLink Functionality 

The current PDMLink 6.2.6.06 architecture and functionality requires administration control and proper methodology to 
effectively use the Pro/E integrated with PDMLink. 
 

1. Access controls to restrict creation of CAD document templates.  As an administrator, CAD Document Templates 

can be created very easily by selecting the create CAD Document Template  in the administration page.  Since 
CAD documents templates cannot be seen in through the Pro/E configuration tool interface, nor can they be found 

through the search function .  This search function is found at the top right corner of the PDMLink front 
page. 

2. Check In only to Pro/E repositories for WTPart and all CAD documents. 

3. Read only access for Non-Pro/E users in Pro/E repositories. 

4. Only use Pro/E configuration tool interface to modify the config.pro options 

5. Have all Pro/E standard CAD documents in Lifecycle state released. 

6. Build a library of common components in a Pro/E library. 

7. Ensure that Oracle tablespaces and external file faults have sufficient space for large amounts of metadata and 
content respectively.  Best practice is take the worst case scenario which is: 

• N - number of users 

• M - max number of modifications per revision. 

• R – max number of revisions 

• P – current number of products 

• S – maximum data size of a complete product (megabytes or gigabytes) 

• F – maximum products produced in a year 

• SF – safety factor (2 recommended) 

External vault size = N x M x R x P x S x F x SF  

  

 


